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 Learning Objectives 
After completing this chapter, you will be able to: 
• Understand the basic concept and general working of FEA
• Understand the types of analyses
• Understand how FEA helps inventor to solve problems
• Understand the important terms and definitions in FEA
• Set analysis preferences and units
• Understand analysis procedure in Inventor Nastran
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INTRODUCTION TO INVENTOR NASTRAN
Autodesk Inventor Nastran is an FEA tool embedded in Autodesk Inventor as an add-in. 
Designed specifically as a tool for predicting the physical behavior of practically any part or 
assembly under various boundary conditions, it offers simulation capabilities spanning across 
multiple analysis types such as linear and nonlinear stress, dynamics, and heat transfer. These 
analyses are mathematical models that has differential equations with a set of boundary values 
and initial conditions for a physical situation. The method used to derive these equations is 
called Finite Element Method (FEM). Inventor Nastran is available as a network license and 
serves multiple CAD platforms, to provide a consistent user experience and eliminate the need 
for multiple single-platform simulation technologies. It delivers high-end simulation technology 
in a CAD-embedded workflow so that you can make great products. 

Apart from analyzing conventional engineering materials, Autodesk Inventor Nastran offers 
solution capabilities such as virtual simulation of structural, thermal, dynamics, and nonlinear 
problems; simulation of the latest advanced materials including composites, plastic, nonlinear 
elastic, shape memory, hyperelastic, viscoelastic; and simulation of brittle materials such as 
concrete.

TYPES OF ANALYSIS
The following types of analysis can be performed by using the FEA software:

1.	 Structural analysis
2.	 Thermal analysis
3.	 Fluid flow analysis
4.	 Electromagnetic field analysis
5.	 Coupled field analysis

Structural Analysis
In structural analysis, first the nodal degrees of freedom (displacement) are calculated and 
then the stress, strains, and reaction forces are calculated from nodal displacements. The 
classification of structural analysis is shown in Figure 20-1. The types of structural analysis are 
discussed next.

Figure 20-1  Types of structural analysis
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Static Analysis
In static analysis, the load or field conditions do not vary with respect to time, and therefore, 
it is assumed that the load or field conditions are applied gradually, not suddenly. The system 
under this analysis can be linear or nonlinear. The inertia and damping effects are ignored in 
structural analysis. In structural analysis, the following matrices are solved:

				    [K] x [X ]= [F]
			   Where, 
					     K = Stiffness Matrix
					     X = Displacement Matrix
					     F = Load Matrix

The above equation is called the force balance equation for the linear system. If the elements 
of matrix [K] are the function of [X], the system is known as the nonlinear system. Nonlinear 
systems include large deformation, plasticity, creep, and so on. The loadings that can be applied 
in a static analysis include: 

1.	 Externally applied forces and pressures 
2.	 Steady-state inertial forces (such as gravity or rotational velocity) 
3.	 Imposed (non-zero) displacements 
4.	 Temperatures (for thermal strain) 
5.	 Fluences (for nuclear swelling)

Following can be the outputs of analysis performed by FEA software:

1.	 Displacements
2.	 Strains
3.	 Stresses
4.	 Reaction forces

Dynamic Analysis
In dynamic analysis, the load or field conditions do vary with time. In this analysis, the 
assumption is that the load or field conditions are applied suddenly. The system can be linear or 
nonlinear. The dynamic load includes oscillating loads, impacts, collisions, and random loads. 
The three main categories of the dynamic analysis are discussed next.

Modal Analysis
It is used to calculate the natural frequency and mode shape of a structure.

Harmonic Analysis
It is used to calculate the response of a structure to the loads that are varying with time 
harmonically.

Transient Dynamic Analysis
It is used to calculate the response of a structure to arbitrary time varying loads.
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Spectrum Analysis
This is an extension of the modal analysis and is used to calculate stress and strain due to the 
response of the spectrum (random vibrations). For example, you can use it to analyze how well 
a structure will perform and survive in an earthquake.

Buckling Analysis
This type of analysis is used to calculate the buckling load and the buckling mode shape. Slender 
structures (thin and long) when loaded in the axial direction, buckle under relatively small loads. 
For such structures, the buckling load becomes a critical design factor.

Explicit Dynamic Analysis
This type of structural analysis is used to get fast solutions for large deformation dynamics and 
complex contact problems. For example, explosions, aircraft crash worthiness, and so on.

Thermal Analysis
The thermal analysis is used to determine the temperature distribution and related thermal 
properties such as:

1.	 Thermal distribution
2.	 Amount of heat loss or gain
3.	 Thermal gradients
4.	 Thermal fluxes

All primary heat transfer modes such as conduction, convection, and radiation can be simulated. 
You can perform two types of thermal analysis by using the FEA software: Steady-State and 
Transient.

Steady State Thermal Analysis
In this analysis, the system is studied under steady thermal loads with respect to time.

Transient Thermal Analysis
In this analysis, the system is studied under varying thermal loads with respect to time.
  

Fluid Flow Analysis
This analysis is used to determine the flow distribution and temperature of a fluid. The outputs that are 
expected from the fluid flow analysis are velocities, pressure, temperature, and film coefficients.

Electromagnetic Field Analysis
This type of analysis is conducted to determine the magnetic fields in electromagnetic devices. 
The types of electromagnetic analyses are:

1.	 Static analysis
2.	 Harmonic analysis
3.	 Transient analysis
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Coupled Field Analysis
This type of analysis considers the mutual interaction between multiple fields. It is impossible 
to solve fields separately because they are interdependent. Therefore, you need a program that 
can solve both the physical problems by combining them.

For example, if a component is bent in different shapes using one of the metal forming processes 
and then subjected to heating, the thermal characteristics of the component will depend on the 
new shape of the component. Therefore, first the shape of the component has to be determined 
through structural simulations. This is known as coupled field analysis.

SIMULATION OF DIGITAL PROTOTYPES
1.	 You can validate the product designs to learn how your parts will perform.
2.	 It allows you to explore design options at the beginning of the design cycle.
3.	 With simulation, you can predict product performance before creating and 
	 testing expensive prototypes.

WHY DO WE NEED FEA?
1.	 Predict performance for planned use.
2.	 Evaluate and correct the observed failure.
3.	 Predict possible failures with predictable abuse.
4.	 Improve the performance and security of a familiar design.
5.	 Develop new and innovative concepts.
6.	 Get information on design concepts or instructions.
7.	 Modeling decisions must be guided by objectives.

GENERAL PROCEDURE TO CONDUCT FINITE ELEMENT 
ANALYSIS USING INVENTOR NASTRAN
The following steps are used to conduct the Finite Element Analysis:

1.	 Create the model
2.	 Assign the material
3.    Idealizations of model
4.    Apply constraints
5.	 Create mesh of the model
6.	 Apply loads 
7.	 Review the result

FEA through Software
The Finite Element Analysis process can be carried out in three main phases using software: 
preprocessor, solution, and postprocessor, refer to Figure 20-2.
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Figure 20-2  The general process of FEA

Preprocessor
The preprocessor is a phase that processes the input data to produce the results, which are used as 
input in the subsequent phase (solution). The following are the input data required in this phase:

1.	 Type of analysis
2.    Geometric Model
3.	 Meshing
4.	 Material properties 
5.    Applying constraints
6.	 Loadings and boundary conditions

The input data are preprocessed for the output data. These data files are used in the subsequent 
phase (solution), refer to Figure 20-2.

Solution
The solution phase is completely automatic. The FEA software generates element matrices, 
computes nodal values and derivatives, and stores the result data in files. These files are further 
used in the subsequent phase (postprocessor) to review and analyze the results through the 
graphic display and tabular listings, refer to Figure 20-2.
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Postprocessor
The output from the solution phase (result data files) is in numerical form and consists of nodal 
values of the field variable and its derivatives. For example, in structural analysis, the output of 
the postprocessor is nodal displacement and stress in elements. The postprocessor processes the 
result data and displays them in graphical form to check or analyze the result. The graphical 
output gives the detailed information about the required result data. The postprocessor phase 
is automatic and generates graphical output in the specified form, refer to Figure 20-2

IMPORTANT TERMS AND DEFINITIONS
There are some important terms and definitions used in FEA software that are discussed next.

Strength
When a material is subjected to an external load, the system undergoes a deformation. The 
material in turn offers resistance against this deformation. This resistance is offered by the 
material by virtue of its strength.

Load
The external force acting on a body is called load.

Stress
The force of resistance offered by a body per unit area against the deformation is called stress. 
The stress is induced in the body due to the load is being applied on the body. The stress is 
calculated as load per unit area.
			   p = F/A

                  			   Where,
                  				    p = Stress in N/mm2 

                  				    F = Applied Force in Newton
                  				    A = Cross-Sectional Area in mm2

The material can undergo various types of stresses which are discussed next.

Tensile Stress
If the resistance offered by a body is against the increase in the size, the body is said to be under 
tensile stress. 

Compressive Stress
If the resistance offered by a body is against the decrease in the size, the body is said to be under 
compressive stress. Compressive stress is just the reverse of tensile stress.

Shear Stress
The shear stress exists when two materials tend to slide across each other in any typical plane of 
shear on the application of force parallel to that plane. In other words, shear stress is generated 
in the body when force is applied parallel to the cross-section of the body. 

Shear Stress = Shear resistance (R) / Shear area (A)
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Strain
When a body is subjected to a load (force), its length changes. The ratio of change in the length 
to the original length of the member is called strain. If the body returns to its original shape 
on removing the load, the strain is called elastic strain. If the body remains distorted after 
removing the load, the strain is called plastic strain. The strain can be of three types, tensile, 
compressive, and shear strain.

	 	 Strain (e) = Change in Length (dl) / Original Length (l)

Elastic Limit
The maximum stress that can be applied to a material without producing the permanent 
deformation is known as the elastic limit of the material. If the stress is within the elastic limit, 
the material returns to its original shape and dimension on removing the external force. The 
following laws are used to define the response of elastic limit.

Hooke’s Law
This law states that the stress is directly proportional to the strain within the elastic limit.
		
		  Stress / Strain = Constant  (within the elastic limit)

Young’s Modulus or Modulus of Elasticity
In case of axial loading, the ratio of intensity of the tensile or compressive stress to the 
corresponding strain is constant. This ratio is called Young’s modulus, and is denoted by E.
				  
		  E = p/e

Shear Modulus or Modulus of Rigidity
In case of shear loading, the ratio of shear stress to the corresponding shear strain is constant. 
This ratio is called Shear modulus, and it is denoted by C, N, or G.

Ultimate Strength
The maximum stress that a material withstands when subjected to an applied load is called its 
ultimate strength.

Yield Strength
The maximum stress that can be developed in a material without causing plastic deformation 
is called its yield strength.

Factor of Safety
The ratio of the ultimate strength to the estimated maximum stress in ordinary use (design stress) 
is known as factor of safety. It is necessary that the design stress is within the elastic limit, and 
to achieve this condition, the ultimate stress should be divided by a ‘factor of safety’.
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Lateral Strain
If a cylindrical rod is subjected to an axial tensile load, the length (l) of the rod will increase 
(dl) and the diameter ( ) of the rod will decrease (d ). In short, the longitudinal stress will not 
only produce a strain in its own direction, but will also produce a lateral strain. The ratio dl/l is 
called the longitudinal strain or the linear strain, and the ratio d /  is called the lateral strain.

Poisson’s Ratio
The ratio of the lateral strain to the longitudinal strain is constant within the elastic limit. This ratio 
is called the Poisson’s ratio and is denoted by μ. The value of  ‘μ’ lies between 0.0 to 0.5.	
		
		  Poisson’s ratio (μ) = Lateral Strain / Longitudinal Strain

Bulk Modulus
If a body is subjected to equal stresses along the three mutually perpendicular directions, the 
ratio of the direct stresses to the corresponding volumetric strain is found to be constant for 
a given material, when the deformation is within a certain limit. This ratio is called the bulk 
Modulus and is denoted by K.

Stress Concentration
The value of stress changes abruptly in the regions where the cross-section or profile of a structural 
member changes abruptly. The phenomenon of this abrupt change in stress is known as stress 
concentration and the region of the structural member affected by stress concentration is known 
as the region of stress concentration. The region of stress concentration needs to be meshed 
densely to get accurate results.
 

Bending
When a force is applied perpendicular to the longitudinal axis of a body, the body starts 
deforming. This phenomenon is known as bending. In case of bending, strains vary linearly 
from the centerline of the beam to the circumference. In case of pure bending, the value of 
strain is zero at the center line. 

Bending Stress
When a non-axial force is applied on a structural member, some compressive and tensile stresses 
are developed in the member. These stresses are known as bending stresses.

Creep
At elevated temperature and constant load, many materials continue to deform, but at a slow 
rate. This behavior of materials is called creep. At a constant stress and temperature, the rate of 
creep is approximately constant for a long period of time. After a certain amount of deformation, 
the rate of creep increases, thereby causing fracture in the material. The rate of creep is highly 
dependent on both the stress and the temperature.
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Degrees of Freedom (DOF)
The degrees of freedom is defined as the freedom allowed to a given object to move and rotate 
in any direction in space.

There are six DOFs for any object in 3-dimensional (3D) space: 3 translational DOFs (one each in 
the X,Y and Z directions) and 3 rotational DOFs (one rotation about each of the X,Y, and Z axes).

STRESS ANALYSIS USING Autodesk Inventor Nastran
To carry out Stress Analysis using Autodesk Inventor Nastran, you need to define the geometry 
on which you want to carry out the analysis. The Stress Analysis can be started by using the 
Autodesk Inventor Nastran tool available in the Environments tab. 

A geometry or a model can be included in the analysis in two ways either by creating a new 
geometry or by opening an existing model in Inventor Professional. To create a new model, 
choose the New button from the Launch panel of the Get Started tab; the Create New File 
dialog box will be displayed. Select the desired template and create the model. 

To open an existing part file, choose the Open button from the Launch panel of the Get Started 
tab; the Open dialog box will be displayed. Browse to the desired folder to open the file. 

Now, as the geometry for the analysis is ready, you can invoke the Autodesk Nastran environment. 
To do so, choose the Autodesk Inventor Nastran tool from the Environments tab of the Ribbon; 
the Autodesk Inventor Nastran contextual tab will be displayed, as shown in Figure 20-3. Now 
you need to specify the initial settings for the analysis with the help of the Default Settings tool. 
This tool is discussed next.

Figure 20-3  The Autodesk Inventor Nastran contextual tab

Defining Default Settings						        
 Ribbon:	 Autodesk Nastran > System > Default Settings  

To perform stress analysis, you first need to define the initial settings. To define the default 
settings, choose the Default Settings tool from the System panel of the 
Autodesk Inventor Nastran contextual tab; the Default Settings dialog box will be 

displayed, as shown in Figure 20-4. Alternatively, you can invoke this dialog by right-clicking in 
the Browser Bar and then choosing the Default Settings option from the shortcut menu. In this 
dialog box, you can specify a name for the analysis, the type of analysis to be carried out, design 
objectives, type of contacts to be used among components, and so on. The options in this dialog 
box are discussed next.

                        Autodesk Inventor Professional 2023 for Designers



Introduction to Inventor Nastran		         	                   20-11                                                               

General
The options under this option are used to specify the settings for the Nastran Wide Field Format, 
Nastran File Settings, Solution Settings, Database Settings, Mesher Settings and ADP Settings 
options. You can use logging option for technical support of the software only. The Help option 
is used to switch between Online Help and the Local Help. 

Display Options
The Display Options is used to display the constraints, loads, max/min on contour, meshes, 
coordinate systems, material orientation, concentrated mass, connectors, free edges, mesh 
control, and so on.

Figure 20-4  The Default Settings dialog box

Nodes
This sub node displays the nodes in the model. The Display Nodes and Display Labels check 
boxes are selected to display nodes with either the displacement coordinate system or id tag. 
You can also change the size and color with the help of the Node Size and Node Color options.

Elements
This sub node is used to display the labels for elements in the model by ID, material, or property.

Post-Processing
This node is used to define the default settings for post-processing options such as loading the 
result of the model, safety factor for the model, number of frames to be used in the animations, 
and so on.
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Report Generation
The options in this node are used to define the settings for report generation of the preprocessor, 
solver, and postprocessor data of the problem after completing the solution. You can only generate 
the reports of Linear Static solutions.

Tree Options
This node is used to simplify the design tree by selecting and clearing the check boxes available 
in the Tree Options area. You can customize the tree options according to the requirement with 
the help of  the Defaults, Check All, and Uncheck All options.

BROWSER BAR
The Browser Bar is the most important component of the Autodesk

Figure 20-5  Partial view of 
the default Browser Bar

 
Inventor Nastran environment and is available below the Ribbon on 
the left of the drawing window. It displays all the operations 
performed during the analysis process in a sequence. All these 
operations are displayed in the form of a tree view. Figure 20-5 shows 
partial view of the default Browser Bar.

NEW
This tool is used to define a new analysis. When you choose this tool, the Analysis dialog will be 
displayed, as shown in Figure 20-6. In this dialog box, you can specify a name of the analysis to 
be performed, the type of analysis to be performed, type of units for the analysis, type of contacts 
to be used in the component, model state of the component and so on. After you specify the 
required parameters, choose the OK button; the new analysis will be displayed in the Model tree.

Figure 20-6  The Analysis dialog box
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EDIT
This tool is used to modify the titles, types of the analysis, units, output control (Displacement, 
velocity, applied load, acceleration, and so on), model state of the components, contact type 
and so on of the current active analysis.

IMPORT FROM STRESS ANALYSIS
This tool is used to import the FEA model from Inventor Stress Analysis environment. Imported 
model includes loads, constraints, materials, midsurfaces, offset surfaces, mesh controls, surface 
contacts, and analysis settings.

MATERIAL PROPERTIES
In the analysis process, you need to assign material properties to the geometry created or 
imported. These properties are based on the analysis type and variation in material properties 
in 3D space. The material properties can be linear or non-linear.

Assigning Materials
  Ribbon:	  Autodesk Inventor Nastran > Prepare > Materials 

To assign materials to a model, choose the Materials tool available in the Prepare panel 
of the Autodesk Inventor Nastran contextual tab; the Material dialog box will be 
displayed, as shown in Figure 20-7. Alternatively, right-click on the Materials sub node 

under the Model node; a shortcut menu will be displayed. Choose the New option from the 
shortcut menu to invoke the Material dialog box.
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Figure 20-7  The Material dialog box

The options in the Material dialog box are discussed next.

Select Material
On selecting the Select Material option, the Material DB dialog box is displayed. You can also 
load the Autodesk Inventor material library. If you want to select another material database, 
then choose the Load Database button from the dialog box.

Name
The Name edit box is used to specify the name of the material of the model.

ID
As a new material is assigned to component, the ID of the material is automatically updated 
sequentially so that it is unique to each of the material entities.

Type
The Type drop-down list has nine material types that are supported in Autodesk Inventor 
Nastran. However, only Isotropic material data can be loaded from the material library. You can 
create and save your own material properties.
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Sub Type
This drop-down list is used to specify material types such as, such as Neo-Hookean, Mooney-Rivlin, 
Yeoh, Ogden, and Polynomial. This  drop-down list is activated only when Hyperelastic is selected 
from the Type drop-down list.

Save New Material
This button is chosen to create and save customised material property to filetype .nasmat.

Analysis Specific Data
This area is used to define the data related to specific analysis such as Nonlinear, Fatigue, PPFA.

General and Structural
The General and Structural areas display the properties of the selected material.

Allowables
This area is used to specify allowable values for tensile strength, compressive strength and shear 
strength, and Failure Theory.

After assigning the material type to the parts, choose the OK button from the Material dialog 
box to close it. The changes that are made to the model are displayed under the material node 
of the Browser Bar.

IDEALIZATION
  Ribbon:	  Autodesk Inventor Nastran > Prepare > Idealization 

Before performing further procedure, you need to idealize the model. Choose the Idealization 
tool available in the Prepare panel of the Autodesk Inventor Nastran contextual tab; the 
Idealization dialog box will be displayed, as shown in Figure 20-8. 
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Figure 20-8  The Idealization dialog box

The various options in the Idealization dialog box are discussed next.

Name
The Name edit box is used to enter the name of the property assigned to a model.

ID
The ID display box is used to display the ID of the property which is automatically updated by 
Autodesk Inventor Nastran.

Type
The Type drop-down list is used to select the type of property for the components. The Solid 
Elements is selected for 3D linear and parabolic tetrahedral elements. The Shell Elements is 
selected for the 2D quadrilateral and triangular elements. The Line Elements is selected for 
1D elements with 6 degrees of freedom.

Line Element Type Area
This area is activated only when Line Element is selected from the Type drop-down list. Three 
types of line elements are available namely Bar, Beam, Pipe.

Add to Analysis
The Add to Analysis check box is used to assign the idealization to the current analysis. This 
check box is activated by default.
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New
The New button is selected to assign the new material for the component. 

Color
This button is used to assign the color of the physical property which will be displayed as mesh 
color in the graphics window. After assigning the required parameters, choose the OK button 
from the Idealization dialog box to close it. 

Connectors
  Ribbon:	  Autodesk Inventor Nastran > Prepare > Connectors 

Connectors are used to create connect between the selected components. To do so, invoke 
the Connector dialog box, choose the Connectors tool available in the Prepare panel of the 
Autodesk Inventor Nastran contextual tab; the Connector dialog box will be displayed, as 
shown in Figure 20-9.  This dialog box is used to specify the name of the connector to be created. 
Also, you can select the type of connector created for the elements such as Rod, Cable, Spring, 
Rigid Body, and Bolt. After specifying the required parameters, choose the OK button from the 
Connector dialog box to close it. 

Figure 20-9  The Connectors dialog box 
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CONSTRAINTS
The constraints are applied to restrict the degrees of freedom of a component or group of 
components. Autodesk Inventor assumes the model under analysis to be fully constrained. This 
means there should not be any rigid body movements or free fall. The Constraints node in the 
Browser Bar shows the constraints applied to the system. 

Applying Constraints
In Autodesk Inventor Stress Analysis, you can apply constraints by using the Constraints tool. 
To do so choose the Constraints tool available in the Prepare panel of the Autodesk Inventor 
Nastran contextual tab; the Constraints dialog box will be displayed, as shown in Figure 20-10. 
The options of this dialog box are discussed next.

Figure 20-10  The Constraint dialog box

Name
This edit box is used to enter a description of the constraint. For example, left face is fixed.

ID
As a new constraint is assigned to component, the ID of a constraint is automatically updated 
sequentially so that it is unique to each of the constraints.

Type
This drop-down list has six constraint types such as Structural, Pin, Frictionless, Response 
Spectrum, Thermal, and Rigid (Explicit).

Selected Entities
This selection box is used to select the face, edge or vertex to specify the location of constarints. 
When you right-click on this selection box; a shortcut menu is displayed. You can choose the 
desired option from it.
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Display Options
This area is used to edit the display option of the constraints such as size, density, and color.

Degree of Freedom
This area is used to specify the degrees of freedom of the nodes associated with the selected 
entities that are to be constrained. 

Minimize/Maximize the dialog
This button is used to minimize or maximize the dialog box.

New
This button is used to add new constraint to the selected entities.

Create Duplicate
This button is used to create the duplicate of current constraint with same settings. You can  
apply the same type of constraint to different entities or apply a different type of constraint 
to the same entities. After setting the required parameters, choose the OK button from the 
Constraint dialog box to close it. 

APPLYING LOADS
 Ribbon:	 Autodesk Inventor Nastran > Setup > Loads 

The Loads node in the Browser Bar displays all the loads that are applied to the model considered 
for the analysis. After the constraints are defined, it is very important that you apply the load 
for which you want to analyze the model. In Autodesk Inventor, only structural analysis is done 
and therefore only structural loads are available. The various loads that can be applied on the 
model are: Force, Pressure, Bearing load, Moment, Gravity, Remote Force, Distributed Load, 
Hydrostatic Load, and so on.

To apply load, you need to specify a point, an edge, or a face on which force needs to be applied. 
When applied on a vertex, the force load becomes point load, whereas when applied on an edge 
or a face, it becomes a uniformly distributed load. By applying a force load, you can simulate 
the behavior of the model under that particular load. To do so, choose the Load tool from the 
Setup panel of the Autodesk Inventor Nastran contextual tab, the Load dialog will be displayed, 
as shown in Figure 20-11. In this dialog box, you can specify the name of the Load, ID of the 
load, types of load, direction of the applied load and magnitude of the load.
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Figure 20-11  The Load dialog box

MESHING THE COMPONENT
A mesh is the discretization of a component into a number of small elements of defined size. 
In FEA, a geometry is divided into various small number of elements. As a result, a number 
of nodes are created which are used to connect the elements. A collection of these elements is 
called as mesh. The tools used for creating the mesh are discussed next.

Generate Mesh
 Ribbon:	 Autodesk Inventor Nastran > Mesh > Generate Mesh   

The Generate Mesh tool is used to create the default mesh in the component by using 
the default settings. These default settings are provided by the system based on the 
geometry to be meshed. To generate the default mesh, choose the Generate Mesh tool 

from the Mesh panel in the Autodesk Inventor Nastran contextual tab. You can also invoke 
this tool from the shortcut menu, which is displayed when you right-click on the Mesh Model 
node in the Browser Bar. 

On choosing this tool, the Mesh Progressing Bar will be displayed, as shown in Figure 20-12 
and  mesh is generated on the component with default settings, refer to Figure 20-13.
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Figure 20-12  The Mesh progress box Figure 20-13  Mesh generated with default 
settings

Mesh Settings
 Ribbon:	 Autodesk Inventor Nastran > Mesh > Mesh Settings 

The Mesh Settings tool is used to set or edit the element length of the mesh. To do so, choose 
the Mesh Settings tool from the Mesh panel of the Autodesk Inventor Nastran contextual tab. 

On choosing this tool, the Mesh Settings dialog box will be displayed, as shown in Figure 20-14. 
In this dialog box, you can set the average element size and minimum element size using the 
corresponding edit boxes. 

Figure 20-14  The Mesh Settings dialog box

SOLUTION PHASE OF ANALYSIS
 Ribbon:	 Autodesk Inventor Nastran  > Solve > Run   

After meshing the model and applying boundary conditions to it, you need to solve the analysis 
problem for the applied boundary condition. In the solution phase, the time taken by the 
computer to perform calculations and solve the problem mainly depend upon the model size and 
the type of solution. To do so, choose the Run tool from the Solve panel of the Autodesk Inventor 
Nastran contextual tab; the output will be displayed in the Browser Bar. Also, the Autodesk 
Inventor Nastran dialog box showing the solution completion message will be displayed, as 
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shown in Figure 20-15. Choose the OK button from the message box; the Von-Mises stress result 
based on the specified settings will be displayed, as shown in Figure 20-16.  

Figure 20-15  The Autodesk Inventor Nastran message box

Figure 20-16  The Von-Mises stress displayed

TUTORIALS
 Tutorial 1

In this tutorial, you will carry out linear static analysis on the model shown in Figure 20-17. The 
model for this tutorial can be downloaded from www.cadcim.com. The path of the file is as follows: 

							             				  

 

Figure 20-17 The model for Tutorial 1

                        Autodesk Inventor Professional 2023 for Designers

file > Model.                                                                                                        (Expected time: 45 min)
Textbook > CAD/CAM > Autodesk Inventor > Autodesk Inventor 2023 Professional for Designers > Input
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The following steps are required to complete the tutorial.

a.	 Download the input file.
b.    Define the settings.
c.	 Start a new study.
d.	 Apply constraints and loads.
e.	 Create mesh.
f.	 Generate the analysis report.
g.	 Save the report file.

Downloading the Assembly File
Before starting the tutorial, you need to download the model from the CADCIM website.

Defining Settings
After downloading the model, you need to open the model to define the initial settings.

1.	 Choose the Autodesk Inventor Nastran tool from the Begin panel of the Environments 
tab; a new environment with the Autodesk Inventor Nastran contextual tab is invoked.

2.	 Choose the Default Settings tool from the System panel of the Autodesk Inventor Nastran  
contextual tab; the Define Settings dialog box is displayed.

3.	 Retain the default settings and choose the OK button.

Starting a New Analysis
After defining the initial settings, the next step is to start the analysis process.

1.	 Choose the New tool from the Analysis panel of the Autodesk Inventor Nastran contextual 
tab; the Analysis dialog box is displayed.

2.	 By default, Analysis X is displayed in the Name edit box. Rename Analysis X to Linear 
Static Analysis.

3.	 Next type Axial Loading in the Title edit box.

4.	 Select the Linear Static option from the Type drop-down list if not selected by default.

5.	 Choose the Select Units button from the Units area; the Units dialog box is displayed. 
Select CAD Model from the Units dialog box. Choose the OK button from the Units dialog 
box to close it.

6.	 Retain the settings of rest of the parameters and choose the OK button; the Linear Static 
Analysis tree is displayed in the Browser Bar.

Download the c20_inv_2023_inp.zip file from www.cadcim.com. The path of the file is as follows:

Model.
Textbook > CAD/CAM > Autodesk Inventor > Autodesk Inventor 2023for Designers > Input file >
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Applying the Material
Now, you need to apply the material to the model.

1.	 Choose the Materials tool from the Prepare panel of the Autodesk Inventor Nastran 
contextual tab; the Material dialog box is displayed. 

2.	 Choose the Select Material button from the Material dialog box; the Material DB dialog 
box is displayed.

3.	 Choose Load Database button from the Material DB dialog box; the Open dialog box 	

Materials, and select the ADSK_materials.nasmat file. 

4.	 Choose the Open button from the Open dialog box and select 16-25-6 Stainless Steel from 
the Steel node in the Material DB dialog box. Choose the OK button from this dialog box.

5.	 Enter 2.5e+008 for Sy and select von Misses Stress from the Failure Theory drop-down 
list.

6.	 Retain the default parameters and choose OK button from the Material dialog box.

Idealizations of the Model
Now, you need to idealize to the model.

1.	 Choose the Idealizations tool from the Prepare panel of the Autodesk Inventor Nastran  
contextual tab; the Idealizations dialog box is displayed. 

2.	 Type Solid Property in the Name edit box and select the Solid Elements option from the 
Type drop-down list.

 
3.	 Make sure that 16-25-6 Stainless Steel is selected in the Material drop-down list.

4.	 Retain the default parameters and choose the OK button from the dialog box; Solid Property 
is added under the Idealization node in the Model tree of the Browser Bar.

Applying Constraints
After applying material to the model, you need to apply constraint to one end of the model.

1.	 Choose the Constraints tool from the Setup panel of the Autodesk Inventor Nastran 
contextual tab; the Constraint dialog box is displayed.

2.	 Type Fixed Left Face in the Name edit box. 

3.	 Select the Structural option from the Type drop-down list and choose the Fixed button 
from the Degrees of Freedom area.

4.	 Select the left face of the model and choose the OK button from the Constraint dialog box; 
the Fixed constraint is applied. 

is displayed. Next, browse to C:\Program Files\Autodesk\Inventor Nastran 2023\In-CAD\

                             Autodesk Inventor Professional 2023 Designers
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Applying the Load
After applying the material and constraints to the model, you need to apply load at the top 
right edge of the model.

1.	 Choose the Loads tool from the Setup panel of the Autodesk Inventor Nastran contextual 
tab; the Load dialog box is displayed. 

2.	 Type Axial Loading in the Name edit box.

3.	 Next, choose the interior face of the left hole of the model.

4.	 Make sure the Components option is selected from the Direction drop-down list.

5.	 Enter 1000 in the Fy edit box in the Magnitude(N) area; the force arrow is modified according 
to the specified direction.

6.	 Choose the OK button from the Load dialog box to apply the load and to close it. 

Creating and Refining the Mesh
After applying the constraints and loads to the model, you need to generate mesh for the model.

1.	 Choose the Generate Mesh tool from the Mesh panel of the Autodesk Inventor Nastran 
contextual tab; the Meshing Progress Bar is displayed. Once the meshing process is done, 
the meshed model is displayed in the drawing area, as shown in Figure 20-18.

Notice that after generating the default mesh on the model, the quality of the mesh is not 
fine. To obtain more accurate results in the linear static analysis of the model, you need to 
generate a good quality mesh. The next step is to discretize the model in such a manner 
that a smooth and good quality mesh is obtained.

2.	 Next, choose the Mesh Settings tool from the Mesh panel of the Autodesk Inventor Nastran 
contextual tab; the Mesh Settings dialog box is displayed. 

3.	 Enter 2 in the Element Size(mm) edit box. Next, choose the Generate Mesh button from 
the Mesh Settings dialog box; the Meshing Progress Bar is displayed. Once the meshing 
process is done, the new meshed model is displayed in the drawing area, as shown in Figure 
20-19. 

4.	 Choose the OK button from the dialog box.
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Figure 20-18  The meshed model with 
default mesh settings

Figure 20-19 The meshed model with refined 
mesh settings

Solving the Linear Static Analysis
After applying all the required settings like constraints, loads, and mesh, you need to solve the 
analysis for the model.

1.	 Choose the Run tool from the Solve panel of the Autodesk Inventor Nastran contextual tab; 
the solution process starts and after the completion of this process the Autodesk Inventor 
Nastran dialog box is displayed. 

2.	 Choose the OK button from the dialog box; the von Mises stress contour is displayed in the 
drawing area, as shown in Figure 20-20.

Figure 20-20  The resultant model with von Mises stress contour

                        Autodesk Inventor Professional 2023 for Designers
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Generating the Analysis Report
Now, you need to generate the complete report of the study for the model. 

1.	 Choose the Generate Report option from the shortcut menu displayed on right-clicking on 
Linear Static Analysis in the Browser Bar; the Report Wizard-Cover dialog box is displayed.

2.	 Choose the Next button six times from the dialog box; the Report Wizard-Glossary dialog 
box.

3.	 Choose the Finish button from the dialog box; the Save As dialog box is displayed. Enter 
the name of the report file in the File Name edit box.

Next, choose the Save button to save this model; the Report message box is displayed 
informing that report is successfully generated.

Tutorial 2
In this tutorial, you will carry out heat transfer and thermal stress analysis of a Flanged 90 Elbow, 
as shown in 20-21. The model for this tutorial can be downloaded from www.cadcim.com. The 

								              (Expected time: 45 min)

Figure 20-21  The model for Tutorial 2

The following steps are required to complete the tutorial.

a.	 Download the input file.
b.    Define the settings.	
c.	 Start a new study.
d.	 Apply material to the Flanged 90 Elbow
e.    Idealization of the Flanged 90 Elbow
f.	 Create the mesh.
g.	 Solve the analysis.

path of the file is as follows: Textbook > CAD/CAM > Autodesk Inventor > Autodesk Inventor 2023

4.  Specify the name of the file asTutorial1.iptand browse to the location

Professional for Designers > Input file > Model.

C :\Inventor_2023\c20.



20-28			     

Downloading the Assembly File
Before starting the tutorial, you need to download the model from the CADCIM website.

Defining Settings
After creating the model, the next step is to define the initial settings.

1.	 Choose the Autodesk Inventor Nastran tool from the Begin panel of the Environments 
tab; a new environment with the Autodesk Inventor Nastran contextual tab is invoked.

2.	 Choose the Default Settings tool from the System panel of the Autodesk Inventor Nastran  
contextual tab; the Define Settings dialog box is displayed.

3.	 Retain the default settings and choose the OK button.

Starting a New Analysis
After defining the initial settings, the next step is to start the analysis procedure.

1.	 Choose the New tool from the Analysis panel of the Autodesk Inventor Nastran contextual 
tab; an Analysis dialog box is displayed.

2.	 By default, Analysis X is displayed in the Name edit box. Rename Analysis X to Flanged 
90 Elbow.

3.	 Next type NL SS Heat Transfer in the Title edit box.

4.	 Select the Non Linear Steady State Heat Transfer option from the Type drop-down list.

5.	 Choose the Select Units button from the Units area; the Units dialog box is displayed. 
Select CAD Model from the Units dialog box. Choose the OK button from Units dialog 
box to close it.

6.	 Retain default settings of rest of the parameters and choose the OK button; the Linear 
Static Analysis tree is displayed in the Browser Bar.

Applying the Material
Now, you need to apply the material to the model.

1.	 Choose the Materials tool from the Prepare panel of the Autodesk Inventor Nastran 
contextual tab; the Material dialog box is displayed. 

2.	 Choose the Select Material button from the Material dialog box; the Material DB dialog 
box is displayed.

Download the file c20_inv_2023_inp.zipfile fromwww.cadcim.com. The path of the file is as follows:

                        Autodesk Inventor Professional 2023 for Designers

Textbook > CAD/CAM > Autodesk Inventor > Autodesk Inventor 2023 for Designers > Input file>Model.
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3.	 Select Load Database button from the Material DB dialog box; the Open dialog box is 

and select the ADSK_materials.nasmat file. 

4.	 Choose Open button from the Open dialog box and select 4130 Alloy Steel, tempered, 

button from this dialog box.

5.   Next enter 150 in the Tref edit box under the General area.

6.	 Make sure that the Thermal check box is selected. Enter 40.33 in the C edit box and 
0.00055555 in the K edit box.

7.	 Select the None option from the Failure Theory drop-down list.

8.	 Retain the default parameters and choose the OK button from the Material dialog box.

Idealizations of the model
Now, you need to apply idealizations to the model.

1.	 Choose the Idealizations tool from the Prepare panel of the Autodesk Inventor Nastran  
contextual tab; the Idealizations dialog box is displayed. 

2.	 Type Linear Solid Property in the Name edit box and select the Solid Elements option 
from the Type drop-down list.

 
3.	 Make sure that 4130 Alloy Steel, tempered, Ultra High Strength is selected in the Material 

drop-down list.

4.	 Retain the default parameters and choose the OK button from the dialog box; the Linear 
Solid Property is added under the Idealization node in the Model tree of the Browser Bar.

Applying the Load
After applying the material and constraints to the model, you need to apply load at the top 
right edge of the model.

1.	 Choose the Loads tool from the Setup panel of the Autodesk Inventor Nastran contextual 
tab; the Load dialog box is displayed. 

2.	 Type NLSSHT Loads in the Name edit box.

3.	 Select Heat Flux from the Type drop-down list.

4.	 Next, select the inside surface of the flange; the surface gets highlighted in blue in color, as 
shown in Figure 20-22.

displayed. Next, browse to

Ultra High Strength from the Steel node in the Material DB dialog box. Choose the OK

C:\Program Files\Autodesk\Inventor Nastran 2023\In-CAD\Materials,

https://example.com;;
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5.	 Enter 0.035 in the Magnitude(mW/mm2) in the Load Definition area.

6.	 Type NLSST Loads in the Name edit box.

7.	 Choose the New button from the dialog box and type Convection in the Name edit box.

8.	 Select Convection from the Type drop-down.

9.	 Select the outer surface as shown in Figure 20-23.

10.	 Select Heat Flux from the Type drop-down.

11.	 Enter 3.858E-5 in the Convection Coefficient -h(mW/(mm2K)) edit box and 70 °F in an 
Ambient Temperature edit box.

12.	 Again choose the New button from the dialog box to define the another load.

13.	 Type Initial Temperature in the Name edit box and select Initial Condition from the Type 
drop-down list.

14.	 Make sure that Temperature is selected in the Sub Type drop-down list.

15.	 Enter 70 in the Temperature(K) edit box in the Load Definition area.

16.	 Choose the OK button from the dialog box and save the model.

Figure 20-22  The meshed model with 
default mesh settings

Figure 20-23  The meshed model with refined 
mesh settings

Creating and Refining the Mesh
After applying the constraints and loads to the model, you need to generate mesh for the model.

1.	 Choose the Generate Mesh tool from the Mesh panel of the Autodesk Inventor Nastran 
contextual tab; the Meshing Progress Bar is displayed. Once the meshing process is done, 
the meshed model is displayed in the drawing area, as shown in Figure 20-24.

                        Autodesk Inventor Professional 2023 for Designers
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Notice that after generating the default mesh on the model, the quality of the mesh is not 
fine. To obtain more accurate results in the linear static analysis of the model, you need to 
generate a good quality mesh. The next step is to discretize the model in such a manner 
that a smooth and good quality mesh is obtained.

2.	 Next, choose the Mesh Settings tool from the Mesh panel of the Autodesk Inventor Nastran 
contextual tab; the Mesh Settings dialog box is displayed. 

3.	 Enter 2 in the Element Size(mm) edit box. Next, choose the Generate Mesh button from the 
Mesh Settings dialog box; the Meshing Progress Bar is displayed. Once the meshing process 
is done, the new meshed model is displayed in the drawing area, as shown in Figure 20-25. 

4.	 Choose the OK button from the dialog box.

Figure 20-24  The meshed model with 
default mesh settings

Figure 20-25  The meshed model with refined 
mesh settings

Solving the Analysis and Post Processing the Result
1.	 Right-click on the Flanged 90 Elbow in the Browser Bar; a shortcut menu is displayed. 

2.	 Choose the Solve in Nastran option from the shortcut menu; the Nastran File Progress 
Window is displayed and solving process starts. After the completion of solution Autodesk 
Inventor Nastran dialog box is displayed. 

3.	 Choose the OK button from the dialog box; the Von Mises stress contour is displayed in the 
drawing area, as shown in Figure 20-26.
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Figure 20-26  The resultant model with von Mises stress contour

 Self-Evaluation Test 
Answer the following the questions and then compare them to those given at the end of the 
chapter:

1.	 In Autodesk Inventor, you can start the Inventor Nastran environment by choosing the 
___________ tool.

2.	 After solving the simulation problems, the maximum stress value can be calculated by using 
the ________ tool.

3.	 The __________ tool is used to generate the solution of the analysis.

4.	 The __________ tool is used to set or edit the element length of the mesh. 

5.	 The __________ button is used to create the duplicate of current constraint with same settings. 

6.	 The __________ selection box is used to select the face, edge or vertex to specify the location 
of constraints. 

                        Autodesk Inventor Professional 2023 for Designers
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 Review Questions 
Answer the following questions:

1.	 The __________ tool is used to generate mesh for a model.

2.	 FEA stands for __________.

3.	 The __________ tool is used to apply material to the model.

4.	 After solving the simulation, the minimum stress value can be located by using the ________ 
tool.

5.	 The tools in the ________ panel of the Autodesk Inventor Nastran  contextual tab are used 
for generating and refining the mesh. 

6.	 An automatically generated mesh can be refined by using the  _________ tool.

EXERCISES
Exercise 1

In this exercise, you will perform the linear static analysis of the model. The holes of the model 
are fixed at its right end and load is applied at its left end, as shown in Figure 20-27. The 
dimensions are shown in Figure 20-28.  The model is made up of alloy steel material.	
								             (Expected time: 45 min)         

Figure 20-27  The model for Exercise 1



20-34			     

Figure 20-28  The dimensions, boundary condition, and loads applied on the model 

Exercise 2
In this exercise, you will carry out heat transfer and thermal stress analysis of a modelas shown 
in 20-29. The dimensions applied to the model are shown in Figure 20-30. The model is made 
up of Steel Alloy material. 			    		       (Expected time: 45 min)

Figure 20-29  The boundary conditions for the model 
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Figure 20-30  The dimensions for the model 
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Answers to Self-Evaluation Test
1. Autodesk Inventor Nastran, 2. Maximum Value, 3. Run, 4. Idealizations, 5. Create Duplicate 
6.  Selected Entities
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